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Excel Fundamentals

Microsoft Excel is a powerful spreadsheet application
that provides quick and accurate numerical calculations
and helps make data look sharp and professional. The
uses for Excel are limitless: businesses use Excel for
creating financial reports; scientists use Excel for
statistical analysis; and families use Excel to help
manage their investment portfolios.

This module will help you get started with Excel. Learn
how to create a new workbook, navigate a worksheet
and save your work so nothing is lost.

Objectives

Understand the Screen
Create Workbooks
Navigate Worksheets
Open Workbooks

Save Workbooks
AutoRecover

The Quick Access Toolbar
Print

Help

Close and Exit

© 2025 CustomGuide, Inc.
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Understand the Screen

There is a lot going on with the Excel program screen, so this lesson will help you become more familiar with
it. Review the labeled items in the images below, then refer to the tables to see what everything does.

B 9~ &~ = B Book - Excel A Kayla Cl c
File Home Insert Draw Page Layout Formulas Data Review  View Help 2 Tell me i
Ifl"j P Calibri |14 - =B & General  ~ | [ Conditional Formatting = i= o
- = A =E=E=FE- -G = -
Do 3 B I U AA | === $ -~ 9% 9 | BEFormatas Table Cells | Editing
- e O A &= 3= ¥n-. &0 .m [E4 Cell Styles ~ . -
Clipboard & Font F} Alignment Iy Mumber P Styles Y
- J‘J’C w
A B C D E F G -
1
2
3
4
5
&
7
a8
2
10
11
12
13
Sheet! | Sheet2 | Sheet3 * 1 ,
Ready H @ - | + 100%

o Title Bar: Displays the name of the current G Display Options: Here you can change how
file. much of the ribbon is displayed, minimize,
maximize or restore the screen, or close
Excel altogether.

Q Quick Access Toolbar: This is a fast way to Q The Ribbon: This is where you’ll find all the
access the most used features. options you need to make a spreadsheet.
The options are grouped into tabs.
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lf_)v (31- = Book - Excel

File Home Insert  Draw Page Layout Formulas Data Review F Help O Tell me 1
2 o b iTren 4 - a o g
Tables strations  Recommended Maps PivotChart Sparklines | Filters | Link Text Sy
N " Charts Q- - - - Map ~ - - . > -
Charts ra ' Tours Links Y
- j;l. W
| A | B | C | D | E | F G |[=
1
2
3 |
4 —
5 —
6 |
? |
8 —
9 —
10|
11
12|
13| .
Sheetl | Sheetz | Sheets | ) [ r
Ready H - | + 100%
o The Tell Me Field: Allows you to find a e Row and Column Headings: Each column is
command by typing it out. This way you labeled with a letter, and each row is
can skip searching through the ribbon tabs labeled with a number; giving each cell a
for a command. unique name.
o Microsoft Account User Info: When you 0 Name Box: Shows which cell is currently
log in with your Microsoft account, your selected.

name and picture appear here.

© 2025 CustomGuide, Inc. 11



Book -

Excel

Kayla Claypool al

File Home E Draw Page Layout Formulas Data Review  View Help 2 Tell me 15
= [® m?ﬂmﬂ@mhﬂﬂ?@ﬂ@@ﬁﬁ
Tables llustrations Recommended Maps PivotChart Sparklines | Filters  Link Text  Symbols
e i T il Pl bl Bl Bl
Charts F} Links -~
Al - S Bon Voyage Excursion R
A B . C D | E | F | G | [~
1 [
2_
3_
4_
5_
6- e
?_
8_
g_
10|
11
12 |
13|
Sheetl | Sheet? | Sheet3 () 4 »
Ready 0 H o] | + 100%

Formula Bar: Displays the information or
formula in the selected cell.

Worksheet: All the cells make up a single
worksheet.

Workbook: Multiple worksheets make up
the workbook, or the file.

Scroll Bars: Use the scroll bars to move up
and down, or left and right in a worksheet.

L
O

Status Bar and Views: The status bar at the
bottom will let you know if the document is
currently saving or if it is ready to be
worked on. Next to it, you can change the
view of the spreadsheet by zooming in or
out.

12
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Create Workbooks

Creating a new workbook is one of the most basic commands you need to know in Excel. You can create a
new, blank workbook or create a new workbook based on a variety of pre-designed templates.

Create a Blank Workbook

Most of the time you’ll want to create a blank workbook.

0 Click the File tab. e
File Home Insert Draw Page Layout Formulas Data Review View Help 2 Tellme
o Click New. ﬂ _ s B &l | o
& B fef&s = = Cells | Editing
o Select Blank workbook. v @@ A = ; B B
Clipboard & Font Alignment Number Styles -~
Shortcut: Press Ctrl + N to quickly
create a new blank workbook.
Excel Kayla Claypoal 7 - O g
A new, blank workbook is created, and New
you can start entering data.
Search for online templates pel
Suggested searches:  Business Personal  Planners and Trackers Lists  Budgets
Charts  Financi ement
A B C
o
2
N Take a tour
4
5
7
Blank workbook Welcome to Excel
Get started with Make your first
Formulas PivotTable
Account
Feedback fJC =

© 2025 CustomGuide, Inc. 13



Create a Workbook from a Template

If you need help getting started with a common document, such as an invoice, expense report, or calendar,
you can use one of Excel’s templates instead of starting from scratch.

Click the File tab.
Click New.
Find the template you want by:

e Searching for the type of
template you want, using
keywords that describe it,
such as “calendar” or
“invoice”.

o Clicking a suggested search,
located below the search
field.

e Selecting the template you
want, if it already appears
on the page.

Select a template style.

Excel will create a new workbook,
based on the template you select.

Book - Excel

Kayla Claypool
File Home Insert Draw Page Layout Formulas Data Review  View Help © Tellme [
X Calibri -no- | = ab, General - | [ Conditional Formatting ~
- | B I U- A= B- | $-% 9 | BHrormatasTable-
. Hel b A == . 8 .0 i Cell Styles ~
Clipboard Font [r] Alignment l Mumber Styles ~
Book - Excel Kayla Claypool 7 = x
{n Home
D New | Peol
B Open Suggested searches:  Business Personal  Planners and Trackers  Lists  Budgets o
Charts  Financial Management
Info
A B C
€L
5 Take a tour
Save As
4
5
3
: ‘
Share Z
Blank workbook Welcome to Excel
Export
Publish
Get started with Make your first
Close Formulas PivotTable
Account
fx -
Book - Excel Kayla Claypool 7 - X
|_|:|'_r Home
< All | Budget Jel
[ New
Budget
= Open *| Category
— Budgets 57
Infa Business 13
Personal 16
S
Save - Financial Management 10
Save As Maonthly T
Planners and Trackers 7
Print Simple monthly budget el 6
o Charts 5
5 =
Share e Projects 5
Er : “ “ ] J = Education 4
bk i ‘
Publish = Industry 4
Database 3
Cl
o Lists 3
Logs 3
Exj trends budget
Account R Marketing 3
Cehad: L 3 s

14 [Your Company Name]



e Click Create.

A new workbook is created from the
template, and you can start populating
it with your own data.

[ Mew

B Open

Info
Save
Save As
Print
Share
Export
Publish

Close

Account

Provided by: Microsaft Corporation

Compare your monthly income to your expenses
and this accessible template will help you visualize
how they stack up. This elegant template will make
managing your finances a breeze.

Download size: 32 KB

o

Simple monthly budget &

© 2025 CustomGuide, Inc.
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Navigate Worksheets

An Excel worksheet can span 16,384 columns and 1,048,576 rows; fortunately, very few worksheets get this
big, but knowing how to navigate through a worksheet is another critical Excel topic you’ll need to know
before you can master Excel. This lesson explains the most common ways to navigate an Excel worksheet.

Select a Cell

Select a single cell by using:

e The Mouse: Click any cell
with the cross pointer.

e The Keyboard: Move the
cell pointer using your
keyboard’s arrow keys.

To help you know where you are in a
worksheet, Excel displays row
headings, identified by numbers, on
the left side of the worksheet, and
column headings, identified by letters,
at the top of the worksheet. Each cell
in a worksheet has its own cell address
made from its column letter and row
number—such as cell A1, A2, B1, B2,
etc. You can immediately find the

address of a cell by looking at the Name

Box, which shows the current cell
address.

-
Paste 127
%

Clipboard =

A

2 |Jan2
3 |Jan 3
4 [Jan 3
5 |Jan 3
6 Jan4
7 [Jan5
sz Jan8
9 (Jan 8
10 |Jan 9
11|Jan 10
12 |Jan 10
13|Jan 11

Ready

File Home

Calibri

Ad e

1 Date

& 2 ¢ -

Insert Draw

fe

Agent
Kerry Oki
Kerrv Oki

o

[ on
' J

Nena Moran
Kerry Oki
Robin Banks
Camille Orne
Paul Tron
Kerry Oki
Camille Orne
Paul Tron
Paul Tron

Sales ®

Page Layout

==

Alignment

1/3/2019

C
Office

Minneapolis
Minneapolis
Paris
Torreon
Minneapolis
Minneapolis
Paris

Paris
Minneapolis
Paris

Paris

Paris

03-navigate-worksheets - Excel Kayla Claypool
Formulas Data Review View Help 2 Tellme [
General - | | [l Conditional Formatting = =] > v bv-
@ -~ % L) ﬁFormatasTab\e' Cells ' }3'
Lo B2 Cell Styles - -
G Number & Styles Editing ~
D E F G -
Excursion Price Packages Total
Paris 5,500 3 16,500
Mexico City 4,500 2 9,000
Mexico City 4,500 4 18,000
Beijing 7,000 3 21,000
Mexico City 4,500 2 9,000
Las Vegas 3,500 2 7,000
Paris 5,500 6 33,000
Mexico City 4,500 7 31,500
Paris 5,500 4 22,000
Beijing 7,000 2 14,000
Paris 5,500 2 11,000
Beijing 7,000 3 21,000
. . = ann A o nn,.’
H [ = 1 + 100%
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Jump to a Cell

The Name Box is an easy way to get to the cell you want.

Click the Name Box.

Type the cell reference you
want to go to.

For example, if you want to go
to cell D4, type DA4.

Press Enter.

Go To Dialog Box

03-navigate-worksheets - Excel Kayla Clay
File m Insert Draw Page Layout Formulas Data Review View Help 2 Tell me [t
fw X Calibri - = ab, General - | [l Conditional Formatting - WOz S -
PasEl O3 - = - EB-% 9 [BHrormatas Table - — H- O-
- == | ® <3 -9 i Cell Styles - - <
Clipboard 1 Alignment 7] Number 7] Styles Editing ~
E9 m A | 1/3/2019 v
A B C D E F G -
1] Date Agent Office Excursion Price Packages Total
2 Jan2 Kerry Oki Minneapolis Paris 5,500 3 16,500
3 Jan3 Kerry Oki Minneapolis Mexico City 4,500 2 9,000
4 |Jan3 _Paul Tron Paris Mexico City 4,500 4 18,000
5 _'Jan 3 Nena Moran Torreon Beijing 7,000 3 21,000
6 Jan4 Kerry Oki Minneapolis Mexico City 4,500 2 9,000
7 Jan5s Robin Banks Minneapolis Las Vegas 3,500 2 7,000
s Jan8 Camille Orne Paris Paris 5,500 6 33,000
9 Jan8 Paul Tron Paris Mexico City 4,500 7 31,500
10 Jan 9 Kerry Oki Minneapolis Paris 5,500 4 22,000
11 Jan 10 Camille Orne Paris Beijing 7,000 2 14,000
1z Jan 10 Paul Tron Paris Paris 5,500 2 11,000
13 Jan 11 Paul Tron Paris Beijing 7,000 3 21,000
N Sale: I ® « v
e — m - 1 + 1005

The Go To dialog box can be helpful when worksheets start getting very large. Here’s how to use it:

Click the Find & Select button

vorksheets - Excel

on the Home tab File Home Insert Draw Page Layout Formulas Data Review View Help 2 Tellm 1 i
fw X Calibri -l = b, General - | [ Conditional Formatting = =R
Select Go To. pasEl @~ |Bplpl o | & & © | @ % 9 | BhiFormatasTable - o | 7 BOE
. H. &-A- ar 4 i Cell Styles - £ Eind...
Enter or Select the Ce” Clipboard Font ® Alignment % Number & Styl oL Replace.. la
£9 - £ || as00 6 T GeTe. v
rEferenCE yOU Want tO gO tO. o Go To Special..
A B | c | D B Formulas -
o CliCk 0. - il Date Agen? GoTo 4 X Pa Comments
2 Jan2 Kerry Ok! M Goto: po Conditional Formatting
3 Jan3 Kerry Oki M [sasa 0o Constants
Shortcut: Press Ctrl + G to openthe Go |+ ‘an3 PaulTron P oo Data Valdation
To dial b 5 Jan3 Nena Moran T 0o b Select Dbjects
O dialog box. & Jan 4 Kerry Oki M 0o v
— . Lk Selection Pane..
7 Jan5s Robin Banks M 00 - e
. s 5 |Jan 8 Camille Orne P 00 6 33,000
Excel jumps to the specified cell. P paul Tronae, p| s o] 731500
10 Jan 9 Kerry okn& oq 0o 4 22,000
11 Jan 10 Camille Orne P{| spedal.. cancel 00 2 14,000
12|Jan 10 Paul Tron Paris Fars 5,500 2 11,000
13 Jan 11 Paul Tron Paris Beijiré 7,000 3 21,000
Sale; ® < v
Ready it mo- 1 + 100%
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Navigation Shortcuts

Excel has several shortcuts that make it fast to get around your worksheets; they’re included in this table:

N T

{ or Enter

1 or Shift + Enter

— or Tab

<« or Shift + Tab

Down one row
Up one row
Right one column

Left one column

Home To column A in the current row
Ctrl + Home To the first cell (A1) in the worksheet
Ctrl + End To the last cell with data in the worksheet
Page Up Up one screen
Page Down Down one screen
Ctrl + G Opens the Go To dialog box where you can go to a
specific cell address
18 [Your Company Name]



Open Workbooks

Opening a workbook lets you use a workbook that you or someone else has previously created and then

saved. This lesson explains how to open a saved workbook, as well as non-Excel files.

Open a Workbook

You can locate a workbook on your computer and simply double-click it to open it, but you can also open a

workbook from within the Excel program.

Book - Excel

Click the File tab.

& 9 ¢

Kayla Claypool

File Home Insert Draw Page Layout Formulas Data Review View Help £ Tell me &
e Click open- X Calibri -l - === 8 General - [Ell Conditional Formatting - = o)
Mm- | BIU- A& =E- m@-% 9  BEfomatasTable- Cells | Editing
Shortcut: Press Ctrl + O to - | HE- e A- o BB Cell Syles - il
quickly display the Open tab of Clipboard = Font ) Alignment F} Number F} Styles ~
the Backstage view.
e Select the location where the - oo 1~ o
file is saved. 0 -
pen
You can choose from:
. , @ Recent Workbooks Folders
e Recent: Recent files you've E—
Pinned
Worked on. RQ Shared with Me Pin files you want to easily find later. Click the |
that appears when you hover over a file.
e Shared with Me: Files i 01Dt ~CustomGuide Today
others have shared with you g ook e
on OneDrive or SharePoint g St CustomGuide 3
Online.
\ . , Z@ This PC
e OneDrive: Microsoft’s -
cloud-based storage. o | () AddaPlace
e This PC: Browse files on your Fustin | = Browe
local computer. i
e Browse: Opens a dialog box Account -
where you can browse
through your computer’s
folders, drives, and network
shares.
© 2025 CustomGuide, Inc. 19




o Select the file you want to
open. G) Mnnn
Open s
H {n} Home
e Click Open. « v 4 [« Users > kayla > Desktop v|®| | searchDesktop )
[ New Organize = New folder =- @ @
= Open 3 Quick access
Todi
Microsoft Excel ls
Info |
f& OneDrive
Save [ This PC 04-open-workbo s
= oks-01
Save As = Network
of Homegroup
Print
Share
Export
Publish File name: | 04-open-workbooks-01 | AN Excel Fles v
Close Tools ~ Cancel
Account 6 -
- ¥

Open a Different File Format

You can also use Excel to open data files created in other programs, like Comma Separated Values or CSV
files.

° Click the File tab. o 04-open-iorkboaks 01 - Excel kayla Claypool

File Home Insert Draw Page Layout Formulas Data Review  View Help 2 Tellme [t
e Click Open. ﬁ % Calibri - Genersl - | [l Conditional Formatting = | i) Jo)
@~ B I U- A& - | E3-% 9 | BHFormatasTable~ "
. - = = Cells | Editing

e Select the location where the =Y @ 0-A- | == | @8 | By |
file is saved Clipboard 1= Font 5 Alignment | Number Styles rs
04-cpen-workbooks-01 - Excel Kayla Claypool 2 - O X

@ Recent Workbooks  Folders
Pinned

RQ Shared with Me Pin files you want to easily find later. Click the |

that appears when you hover over a file.

G OneDrive - CustomGuide Uity

S Book |
12/18/2018 12:5
save bZ pocumentsco.. 0¥
Save As ® Sites - CustomGuide E

Print _
Emm| This PC
Share
@ Add a Place
Export
Publish B Browse
Close
Account -
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00 0 O

Click the file type list arrow
and select All Files.

Select the file you want to
open.

Click Open.

If prompted, complete the
steps in the Text Import
Wizard.

mr\r\n

Iv]

Open b4
« v 4 B« Users > kayla > Desktop ~v & | Search Desktop »
Organize v New folder SRS G R [ ]
All Files
All Excel Files
# Quick access Excel Files the |
All Web Pages
Microsoft Excel ML Files
Info Text Files
@ OneDrive All Data Sources
Access Databases 12:5]
Save = This PC 04-open-workbo Query Files
oks-01 dBase Files
Save As 2 Network Micrasoft Bxcel 4.0 Macros
Microsoft Excel 4.0 Workbooks
& Homegroup Workshests
Print Workspaces
Templates
o Add-ins
Share Toolbars
SYLK Files
Export Data Interchange Format
Backup Files
OpenDocument Spreadsheet
Publish File name: Al Excel Files ~ =
Account hd
[+]
m [aVal el
Open x
« < 4 M« Users » kayls > Desktop v © | Search Desktop o
Organize ~ New folder =~ m @
st Quick access the |
] Microsoft Excel
Info
@ OneDrive
12:5]
Save [ ThisPC Bon Voyage M4-open-workbo Customers
= Excursions oks-02 Report
Save As ¥ Network
 pe—
*§ Homegroup —
Print
Share
Excursion
Export Proposal
Publish File name: | 04-open-workbooks-02 v\ All Files R B

Close

Account

ookl s
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File Types Commonly Opened in Excel

All Files (Any) Displays all file types (although Excel might not be able to
open all of them).

All Excel Files xls and related Displays Excel workbooks, templates, and macro-enabled
files.

All Web Pages .htm and related Displays web pages, including supporting files such as
images.

Text Files txt and .csv Displays comma and tab delimited text files, often used to

import / export data.
All Data Sources (Varies) Displays databases (e.g. Microsoft Access) and queries.

Templates xlt and related Displays Excel template files.

22 [Your Company Name]



Save Workbooks

After you’ve created a workbook, you need to save it if you want to use it again. Also, if you make changes
to a workbook you’ll want to save it. You can even save a copy of an existing workbook with a new name, to
a different location, or using a different file type.

Save a Workbook

Once you’ve created a new workbook, you’ll need to save it if you want to use it again.

Click the Save button.

Shortcut: Press Ctrl + S to
quickly save a workbook.

If this is the first time you’ve
saved the workbook, the Save
As screen will appear.

Choose where you want to
save your file:

e OneDrive: Save to
Microsoft’s cloud-based
storage so you can open the
worksheet on another
computer.

e SharePoint: Save the
workbook to a connected
SharePoint server.

e This PC: Save to the local
storage on your computer.

e Browse: Opens a dialog box,
where you can browse
through your computer’s
folders, drives, and network
shares.

Enter a file name.

Click Save.

Book - Excel

Kayla Claypool

File Home 1 art Draw Page Layout Formulas Data Review View Help 2 Tell me [t
ftl & Calib -1 - General ~ [l conditional Formatting Eﬂ p

- - S OAY 5+ O Fi it as Table =
Paste IE] b oo G - % 9  HEFomatasTable Cells | Editing

. = = A Lo 5 Cel Styles - - -

Clipboard & Font ® Alignment % Number & Styles ~
Al b J | First b

A B C D E F G -
1 |First] |
2
3
4
5
6
7
8
9
10
1
12
13

Sheet1 ® 4 v
Ready B |- 1 + 100%
Baok.xlsx - Excel Kayla Claypool ¥ = ] X
{n} Home
= OneDriye - CustomGuide

[ Mew

= Open

Infa
Save
Save As
Print

Share

Export

Recent

©

OneDrive - CustomGuide
kayla@customguide.com

Sites - CustomGuide
kayla@customguide.com

Em) This PC
Add a Place

Browse

Publish

Close

Account

My Warkbook]|

(52 save

Excel Workbook (*.xlsx) et
WMore options...

Name T Date modified

D Attachments
D Documents
Bon Voyage Excu...

11/27/2017 %33 AM

5/31/2018 %:21 AM

12/20/2018 11:12 AM

© 2025 CustomGuide, Inc.

23



AutoSave Workbooks

If an Excel file is saved online, the AutoSave feature in the top-left is automatically turned on. However, this
can be changed as needed.

a Click the AutoSave toggle P—
button to tu rn the featu re on File 1 Insert Draw Page Layout Formulas Data Review View Help S Tellme 5
or Off fﬁ rs alibri -1~ General - | [ Conditional Formatting - =] o

i - B T U- A A E3- 9% 9 | BHFormatasTable- Cells | Editing
B - A S8 48 B2 Cell Styles - - -
Clipboard = Font LM Alignment I Mumber I Styles ~
Al = 5 First v
A B © D E F G -
1 |First
L "
2 —
3 —
4 a
3 —
6 a
7 —
8 a
9 —
10|
11
12
13
Sheet1 ® < ¥
Ready FH m - 1 + 100%

Save Progress

As you continue to work in Excel, you'll want to save any changes you make from time to time.

o Click the Save button. AutoSave @ 0N [T O - (- MJWorkbook 44k = Saved Kayla Claypool

File Home art Draw Page Layout Formulas Data Review  View Help  © Tellme [t
Shortcut: Press Ctrl + S to quickly save fﬁé e —=E Grc'y - g?”““f"i:'m"g' @ |0

. u- = - % ormat as Table - Pl s

a workbook. P ¢ . oA - e cets | eding

Clipboard [ Font [ Alignment ml Mumber & Styles ~
Tip: Try to save your progress every 10 81 - X W et v

H . ’ | A B C D E F G .

rmnutes, that way you won t Iosg any P o ]
important changes if disaster strikes. 2|

3

4_

5 o

6_

7,

8_

9,

10_

117

12_

13_

Sheet1 ()] [ 3
Ready HE m - ] + 100%
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Save As a New File and/or Location

Sometimes you may want to make a copy of an existing workbook and save it with a new name. Using and
modifying the content in an existing workbook can often save you a lot of time.

c Click the File tab. e B fara Claypsol

File Home Insert Draw Page Layout Formulas Data Review  View Help 0O Tellme [

CIICk Save AS' ‘}Q Calibri -1 - General - fE Conditional Formatting = Eﬁ p
. . . @™- B I U- AN B+ % 9 | BHFormatas Table~ Cels | Edting
Click This PC to navigate to the g mEelo-A- . I Celistyles - il

folder yOU Want tO save yOUr Clipboard 15 Font [ Alignment ml Mumber & Styles A
file.

8 9o

Enter a File name. My Waorkbook.xlsx - Excel Kayla Claypool 7 - ] x
Click Save. Save As
@ [ OneDrive - CustomGuide
Recent
My Workbook
Excel Workbook (*.xls¥) - [Z save

OneDrive - CustomGuide

Mare options...
kayla@customguidz.com

® Sites - CustomGuide Name T Date modified
kayla@customguide.com
E Attachments 11/27/2017 %:33 AM

1 ThisPC
L o ] Documents 5/31/20189:21 AM

P = N
k @ Add a Place Bon Voyage Excu..  12/20/2018 11:12 AM

Share
B Browse

Export

Publish

Close

Account hd

@ [ Save As x
£ Home [ v 4 > ThisPC > Desktop v & | Search Desktop £

[ New Organize v New folder = @

[ This PC A MName Date modified Type

e (5% Save

9AM  Filefol
1211PM  Filefol
9AM  Filefol

[ Desktop Agents Report
Documents Audios

Info 3 Dovinloads Customers Files
) New Excursions Information M Filefol|
B Movies

Save Sales Reports 7 T1216PM  File fol
D Music D:34 AM

Tomi [&] Pictures

. Network Drive ( AM
w

Print = @DevWBTon'fyv ¢ 5
Share File name: NEwWorkbnokI -

Save as type: | Excel Workbook (*xdsx) ~
Export

Authors:  Kayla Claypool Tags: Addatag
A [] 5ave Thumbnail
Cl
Account -
4 +
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Save to Different File Formats

Excel normally saves its files as Excel workbooks, but you can save information to other file formats as well.
For example, sometimes you may want to save your data as a Comma Separated Values or CSV file, so you
can import it into another program.

c Click the File tab. = New Workbook.sx - Excel Kayla Claypool
File Home Insert Draw Page Layout Formulas Data Review  View Help 2 Tellme it
e Click Save As. % Calibri NPT General - | [E] Conditional Formatting = | g Jo)
- B I U- A A B3~ 9% 9 | HHFormatasTable- Cells | Editing
e Click the Save as type list TS | m a8 | By nalll s
arrow Clipboard & Font ] Alignment Gl Number Styles A

The default file type is an XLSX

Excel file, but you can choose New Warkbookals: - Excel KeyaClaypool 2 — O X
from plenty of other file ® Save As :
formats in this menu.
{n} Home
. . = Documents
o Select the desired file format. [ New (O Recent ;Ewwmmk 9
Excel Workbook (*.xlsx] - Save
e ClICk SaVe, = G G OneDrive - CustomGuide Excel Workbook o =
kayla@customguide.com -
Excel Macro-Enabled Workbook (*xlsm)
Infa Excel Binary Workbook (*xdsb) 6
@ Sites - CustomGuide Excel 97-2003 Workbook (*xis) d
Cave kayla@customguide.com CSV UTF-8 (Comma delimited) (.csv)
ML Data (*xml) :34 AM
Save As ;I;I This PC Single File Web Page (*.mht, *mhtml)
] Web Page (%.htm, *html) AM
Print + Excel Template (".xlt)
@ Add a Place Excel Macro-Enabled Template (*.xltm)
. Q Excel 97-2003 Template (*xlt)
[Text (Tab delimited) (*.bet)
E’ Browse Unicode Text (*.txt)
Export 4L Spreadsheet 2003 (*xml)
Microsot Excel 5.0/95 Werkbook (*s)
Publisty ICSV (Comma delimited) (*.csv)
Formatted Text (Space delimited) (*.prn)
Close IText (Macintosh) (*.txt)
Text (MS-DOS) (.bxt)
ICSV (Macintosh) (*.csv)
Account ICSV (MS-DOS) (*.csv) e . A
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File Types Commonly Saved to From Excel

Ccsv
Excel Workbook

Excel 97-2003
Workbook

Excel Macro-
Enabled Template

Excel Template

PDF

Web Page

.CSV
XIsx

Xls

Xlsm

Xltx

.pdf

.html

Comma delimited text file, often used to import/export data.

The default XLM-based file format for Excel, in use since Excel 2007.

Excel files from Excel 2003 and older.

Excel template that contains macros.

Excel template files.

Portable Document Format, a format that preserves document
formatting and allows file sharing.

A web page that is saved as a folder and contains an .htm file and
supporting files, such as images.

© 2025 CustomGuide, Inc.
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AutoRecover

Computers don’t always work the way they’re supposed to. Nothing is more frustrating than when a
program locks up and stops responding, or worse, completely crashes—especially if you lose progress on an
important spreadsheet that you’re working on.

Fortunately, Microsoft realizes that people might want to recover their workbooks when something
catastrophic happens. If Excel 2019 encounters a problem and stops responding, you can restart Excel or
your computer and try to recover your lost workbook.

Recover a Workbook

If Excel crashes, it will display the Document Recovery Pane the first time you open Excel again.

o Restart Microsoft Excel. E

If an unsaved workbook can be [
recovered, a Recover unsaved
workbooks heading will appear
on the Welcome screen.

9 Click Recover unsaved
workbooks.

The Recovery pane appears,
listing all recovered workbooks
that were found.

m ) B

Excel Kayla Claypool 7 - O X

Good afternoon

3 ] Get started with

e i
Take a tour Formulas

Blank workbook Welcome to Excel 57 Formula tutorial ~ =*

More templates —>

Recent  Pinned Shared with Me

You haven't opened any workbooks recently. Click Open to browse for a warkbook.

Recover unsaved workbooks More workbooks —>

Account

Feedback

Options
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Select the workbook from the
Document Recovery pane.

The last AutoSaved version of
that workbook opens.

Click Close.

Book - Excel
File Home Insert Draw Page Layout Formulas Data Review  View Help P Tellme [
ﬁil X Calibri -4 - ab, General - | [l Conditional Formatting = =1 0
o - | B I U- A& - $-9% 9 [HHFormatasTable- Cals | Editing
S G-A- |ZE|®- @H R CelStyles~ -
Clipboard 1 Font LM Alignment ] Number ] Styles ~
Al e k& Bon Voyage Excursions b
A B | C | D | -
Document Recovery 1 [Bon Voyage lecursiuns
Excel has recovered the following files. Save 2 -
the ones you wish to keep. 3 [Excursion Jan Feb Mar T
4 | Beijing 6,010 7,010 6,520
ﬁ Bookxlsx [Oniginal] 5 |Las Vegas 35,250 28,125 37,455 1
X Version created last time the... 3| . .
ST R T 6 Mexico City 20,850 17,200 27,010
7| Paris 33,710 29,175 35,840
6 8 _Tokyo 12,510 14,750 11,490
) Total 108,330 96,260 118,315 3
10
11_
( 12
(@ which file do | wantto save? 13
cl =
i Summary @ ] v
Ready H m - ] 00%
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AutoRecovery Settings

If the workbook that you were hoping to recover doesn’t appear, it’s probably because the AutoRecovery
settings didn’t catch it. Excel periodically saves a copy of your file. By default, this setting is every 10
minutes, but you can easily change it so that it’s a bit more diligent about auto-saving your workbooks.

Click the File tab.
Click Options.
Click Save.

The AutoRecovery settings are
here. Make sure that the
proper checkboxes are
checked.

Make sure Save AutoRecover
information checkbox is
checked and adjust the time
interval.

Tip: You can’t specify the
interval if the checkbox is not
selected.

Click OK.

Book - Excel

Kayla Claypool

File Home Insert Draw Page Layout Formulas Data Review  View Help P Tellme [t
02@ Calibri -a - Genersl = | [l Conditional Formatting + 1 Jo!
. A A .0 Format as Table ~
e B IU- AAX $-% 9 | HHformstasTable Cells | Editing
. s el dh A 8 -0 B2 Cell Styles ~ - -
Clipboard & Font ] Alignment Gl Number Styles ~
Book - Excel Kayla Claypool 7 = O X
Book
Desktop
& Upload |¥% Share @ Copy path | | B> Open file location
E Protect Workbook Properties -
& Control what types of changes =n -
Save As Protect people can make to this workbook.
Workboolk - Title Add a title
Print Tags Add atag
Categories Add a category

Share

Export

Publish

Close

Inspect Workbook

Before publishing this file, be aware
that it contains:

Related Dates
Check for

I - Last Modified
ssues = Document properties, printer
path, author's name and Created
absalute path Last Printed

Related People
Manage Workbook =

Qe '_j Author
Ml'EI 1) There are no unsaved changes. K  Kayla Clay~
v

Excel Options ? x

General . *

i Customize how workbooks are saved.
Formulas
Save workbooks
ofing AutoSave OneDrive and SharePoint Online files by default on Excel @

Save Save files in this format: Exccel Workbook =

Language G Save AutoRecover information every [§ -] minutes

Ease of Access
Advanced
Customize Ribbon
Quick Access Toelbar
Add-ins

Trust Center

Keep the last AutoRecovered version if | close without saving

AutoRecover file location: C:\Users\Kayla Claypool\AppData‘\Roaming\Microsoft\Excel\
[J Don't show the Backstage when opening or saving files with keyboard shortcuts

Show additional places for saving, even if sign-in may be required.

[ Save to Computer by default
Default local file location: \\Mac\Home\Documents
Default personal templates location:

Show data loss warning when editing comma delimited files (*.csv)

AutoRecover exceptions for:

[ Book.xsx -

[ Disable AutoRecover for this workbook only

Offline editing options for decument management server files
Saving checked out files to server drafts is no longer supported. Checked out files are now saved to the Office
Document Cache.
Learn more
Server drafts location: \\Mac\Home\Documents\SharePoint Drafts\

Cancel

-
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The Quick Access Toolbar

The Quick Access Toolbar is located above the ribbon and contains buttons for commands that you’ll use
often, such as save and undo. You can also add your own frequently-used commands to the Quick Access

Toolbar.

Add a Button to the Quick Access Toolbar

You can add frequently used commands to the Quick Access Toolbar.

o Click the Customize Quick

07-the-quick-access-toolbar - Excel Kayla Claypool

Access Toolbar button- File Home Insert Draw Customize Quick Access Toolbar|  Data Review  View Help 2 Tellme &
ﬂD X Calibri L[11 v Automatically Save - Econcitional Formatting = | (g o
o Select a command to add. pot 7 (BT U~ & A N b3 |l Format s Tabe - cels | Editng
N H. b A Open [52 Cell Styles - = >
Clipboard 1 Edfil v Save & Styles ~
The command is added to the Quick = m -
Quick Print
Access tOOIbar' | A B Print Preview and Print e J E F -
1 |Bon Voyage l_xcursiuns Spelling '
2 v Undo
3 Excursion Jan v Redo Total
4 |Beijing 6,01 Sort Ascending 520 19,540
5 las Vegas 35,25 Sort Descending 455 100,830
& Mexico City 20,85 Touch/Mouse Mode 010 65,060
7 Paris 33,71 More Commands... ,840 98,725
& Tokyo 12,51 Show Below the Ribbon 490 38,750
g Total 108,330 96,260 118,315 322,905
10
"
12
13 =
Summary o] ] v
Ready it |- ' 100%
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Customize the Quick Access Toolbar

If you don’t see the command you want to add to the Quick Access Toolbar in the list, you can select More

Commands to find it.

c Click the Customize Quick
Access Toolbar button.

o Click More Commands.

e Select the command you want
to add.

o Click Add.
e Click OK.

The command is added to the Quick
Access Toolbar.

[iF? 1 bick-access-toolbar - Excel

Kayla Claypool

File Home  Insert Draw Customize Quick Access Toolbar ata Review  View Help O Tellme &
f’lil X 1 Automatically Save fEf Conditional Formatting = TH] o
E New
= 3 Format as Table =
pase 2 : B Format = IR Cells | Editing
.o i Open [ Cell Styles - < >
Clipboard T Font o v Save b Styles ~
Emnail
i X Al v ouickprint i
A | B | Print Preview and Print B | F | G [+]
1 |Bon Voyage llxcursions Spelling
A e
2 | v Undo
3 Excursion Jan ¥ Redo Total
4 Beijing 6,010 Sort Ascending ) 19,540
5 Las Vegas 35,250 Sort Descending » 100,830
6 | Mexico City 20,850 Touch/Mouse Mode ) 65,060
7 Paris 33,71 More Commands... ) 98,725
s Tokyo 12,51 Show Below the Ribbon ) 38,750
9| Total 108,330 96,260 118,315 322,905 B
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|
12|
13|
Summary | ® [«I ] [»]
Ready ] m - 1 + 100%
Excel Options ? x
General
{[E] Customize the Quick Access Toolbar.
Formulas
Choose commands from: @ Customize Quick Access Toolbar:®
Dat
o Popular Commands - [ For ail documents (default) -
Proofing
Save <Separator> T= AutoSave
Add or Remove Filters Save
Language AutoSave ) Undo [»
Ease of Access i Borders D ' Redo [r
Calculate Now F3 Quick Print
Advanced ’ Center B2 Email
Customize Ribbon Conditional Formatting 3
Copy
Quick Access Tooll Create Chart PR E
Y. Custom Sort...
dd-ins Cut << Remove
Trust Center " Decrease Font Size

Delete Cells...

E

Delete Sheet Columns

%
=% Delete Sheet Rows
Email
Fill Color |v
Eont ihs

[ Show Quick Access Toolbar below the

Ribbon

Crtomizions 5

[«

Import/Export ¥ |
]

& = 1 ]
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Remove a Button from the Quick Access Toolbar

It's easy to remove a button from the Quick Access Toolbar.

a Right-click the button you want oyt Caypocl
to remove File Home Insert Draw Pi Bemovefrom Cuick Ac liew Help 2 Tell me [t
: Gy = _| Customize Quick Access Toolbar...
S I f . k ﬁj E?L . C:Ih; N “ 24 A: ; Show Quick Access Toolbar Below the Ribbon ;ri\attmg' Eﬁ /o
o elect Remove from Quic L Al s R - cets | zamng
Access Toolbar. A e R L B, .
Al oy b3 Bon Voyage Excursions o
The command is deleted from the A 8 c o c . s N
Quick Access Toolbar. 1 [Bon Voyage xcursions
2
3 :Excursinn Jan Feb Mar Total
4 | Beijing 6,010 7,010 6,520 19,540
5 |Las Vegas 35,250 28,125 37,455 100,830
& Mexico City 20,850 17,200 27,010 65,060
7 Paris 33,710 29,175 35,840 98,725
3 Tokyo 12,510 14,750 11,490 38,750
9 Total 108,330 96,260 118,315 322,905
10|
11|
12|
13|
=] Summary ® ] v
Ready H m - ] + 100%
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Print

Once you’ve created a worksheet, and your computer is connected to a printer, you can print a copy. Before
you do this, it’s a good idea to preview how it’s going to look.

Preview and Print a Worksheet

You can preview and then print a worksheet as part of the same operation.

0 Click the File tab. g 03 i = rcel Kaita Claypooi
File Home Insert Draw Page Layout Formulas Data Review  View Help 2 Tellme 5
e Select Print. Genersl - | [l Conditional Formatting = | gy Jo)
5+ % 9 | [HFormatasTable~

Cells | Editing

The Print tab is where you'll i B CellSyles -
flnd the print preVieW. Clipboard 15 Font i Alignment | Number & Styles A

e Click Print.

08-print - Excel Kayla Claypool 2 - 0 e
Shortcut: Press Ctrl + P to quickly print ® Print e
a worksheet. .-

o e E] Copies: | 1 > -

[B] Mew

Print o
= Open
A Printer ; |
Info

HP LaserJet Professional P 1...

’% Ready

Save
Printer Properties

Savels Settings Ill Ill II

Print @ Print Active Sheets
Only print the active shests
Share Pages: “te S
Collated
e L0 155 123 123 ¥
[0 D Portrait Orientation -
Close D Letter
r 85" x11"
B count E Normal Margins
Left: 0.7" Right 0.7"
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Specify Printing Options

Sometimes you will want to specify more printing options, such as the number of copies to print.

€) ClcktheFile tab. 9 Q- - o - e
) File Home Insert Draw Page Layout Formulas Data Review  View Help  © Tellme [t
e Select Print. o =

X Calibri -1 - — General - | [l Conditional Formatting ~ =t Jo)
- BIU- AN | =Z==ZBE- @E-% 9  HEHFormatasTable-
. . = Cells Editing
e Select the desired print S ¥ HEoe A (2= 9 |98 | By ol | B
OptionS' Clipboard 1 Font [ Alignment ml Mumber Styles A

e Number of Copies you want
to print.

08-print - Excel Kayla Claypool 7 - O X

Print
ES,] Copiest |5 =

e Printer where you want to
send the worksheet.

o Print Area you want to

Print
print. A
| Printer
° Page Orientation. = HP Deskjet F4100 series ¥
Ready

Printer Properties

o Click Print. —
Settings o O
Print Entire Workbook & III III III

Print the entire workbook

<] o 5

Collated
123 123 123

Pages
|
Publish [ tendscape Orientation -

Close
Custom Page Size 5

Normal Margins
Left 07" Right 0.7"

Account
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Customizable Print Options

Print Option Description
) Specify the number of copies you want to print.
Copies: |1
HP Laserlet Professional P 1. Select the printer you want to use (if you have more than one).
'ﬁ Ready
@ Print Active Sheets . Print the active worksheet, the entire workbook, or a selection of cells.
Only print the active she...
—  Collated If you are printing multiple copies, you can select collation options.
EE : - y p 8 p pies, y p
23 123 123
e e . Select between portrait or landscape orientations.
D Letter . Select the paper size you want to print on.
2159 cmx 2794 cm
@ Mormal Margins . Adjust page margins.
Left 1.78cm  Right 1.
O MNeScaling . Reduce the print scale, to include more text on the printout.
100 Print sheets at their actu...
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Help

The Excel Help feature can answer questions and offer tips to help you get the most out of Excel’s tools.

The Tell Me Field

If you look at the ribbon, you'll notice a field that says Tell me what you want to do. You can use this field to
enter keywords and phrases about what you want to do, and get help with that.

o Click in the Tell Me field. 2 0%-help - Bce Ko Caypoot
File Home Insert Draw Page Layout Formulas Data Review P 2 grid x [
e Type What you wa nt to do' E"I & Calibri -1 = EE} General - fEfl cq Actions
U B-| B I U~ A& - % % [HErd Print Gridlines
Commands related to your s @ oA =|®e | @ BB v show Gridines
sea rch, from a“ the different Clipboard 1= Font & Alignment Number 13 [E= Align Objects »
»
ribbons, are grouped into this i = w Eg‘p
A y - c o Get Help on "gridlines” v
menu. 1 Bon Voyage Excursions | C’? Gitmcrirﬁ:ltz
2 T————
e SeIeCt the Command you are 3 Excursion Jan Feb Mar Tust::rtmmp L
Iooking for. 4 | Beijing 6,010 7,010 6,520 19,540
5 |Las Vegas 35,250 28,125 37,455 100,830
6 | Mexico City 20,850 17,200 27,010 65,060
7 |Paris 33,710 29,175 35,840 98,725
s | Tokyo 12,510 14,750 11,490 38,750
9 Total 108,330 96,260 118,315 322,905
10
1
12
13
(s [ @ . G
e — m - 1 + 1005
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The Help Pane

When you don’t know how to do something in Excel, look up your question in the Excel Help files. The Excel
Help articles can answer your questions, offer tips, and provide help for all of Excel’s features.

c Click the Help tab. SIS 09-help - Excel

. File Home Insert Draw Page Layout Formulas Data Review View HLIp 2 Tell me [t
shortcut: PreSS F1. Help ;:):;aoc: Feedback T;:r:::fg V\;‘Ih::;s Community ?,?: :::agtjta 0
6 Help Community ~
A pane opens with help topics. m & z
. . A | B | z D E | E | 5 =
e Type a help topic and click the | = 0 o
Search button. 2 |
3 Excursion Jan Feb Mar Total
o Select a topic. 4 Beijing 6,010 7,010 6,520 19,540
5 |Las Vegas 35,250 28,125 37,455 100,830
. . . . 6 Mexico City 20,850 17,200 27,010 65,060
Note: Help in Office is online and 7 Paris 33,710 29,175 35,840 98,725
H H s Tokyo 12,510 14,750 11,490 38,750
requires a connection to the Internet. ] Total 108,330 06,260 118,315 322,905
10|
11
12|
13|
Sheet1 (O] [ »
Ready B mo- 1 + 100%

9 Q- s 09-help - Excel Kayla Claypool
File Home Insert Draw Page Layout Formulas Data Review View Help  © Tellme A
i
@820 KV A
Help Contact Feedback Show What's = Community Blog Suggest
Support Training  Mew Site a Feature
Help Community ~
- f;‘ v
A B | B

d - - x
1 |Bon Voyage Excursions Help
2 —
3 Excursion Jan Feb & ---  Data Validation x O o
4 |Beijing 6,010 7

| . . ~
5 Las Vegas 35,250 28 Apply data validation to cells
6 Mexico City 20,850 17 Use data validation rules to control the type of data or the values
7 |Paris 33,710 29 that users enter into a cell. One example of validation is a drop-
s |Tokyo 12,510 14 down list (also called a drop-down box or drop-down menu).
9 Total 108,330 o More on data validation
10 To quickly remove data validation for a cell, select it. and then go
1) to Data > Data Tools > Data Validation > Settings > Clear All. To
12 find the cells on the worksheet that have data validation, on the
= ~|| | Remove a drop-down list >

She @ 1 v Tr i e deein ot clicl Hho ool with bhe ok thon olicl

Ready B mo- 1 + 100%

38 [Your Company Name]



Close and Exit

When you're done working with a file, it's a good idea to close it so you don't bog down your computer with

unused programs.

Close a Workbook

Each spreadsheet window must be closed individually. When you have only one spreadsheet open and want

Excel to stay running:

Click the File tab.

10-close-and-exit - Bxcel

Kayla Claypool

. File Home Insert Draw Page Layout Formulas Data Review View Help O Tellme [y
CIICk the ClOSE bUtton' X Calibri - = ab, General - [ Conditional Formatting - = 0
- - E3-% 9 EHrormatas Table- Cells | Editing
Shortcut: Press Ctrl + W to ) ==(5 | Qs G Cell Styles - il
close a WOI’kbOOk. Clipboard 1 Font I Alignment ml Number Styles -~
Tip: You can close all open
workbooks by holding down i etk = B KaylaClaypool 2 — O X
the Shift key as you click the Info -
Close button.
. Book
If you have multiple Desktop
WOI‘kSheetS Open' you'” need ¢ Upload | Share @ Copy path = Open file location
to close each of them
individually.
o . Protect Workbook Properties -
The file is closed but Excel is & Control what types of changes e 0
St| “ runn | ng. w:rfl:sk- people can make to this workbook. e T
Tags Add atag
Categories Add a category
e If prompted, select from one of - ine et Workbook
the following options: Q) s e Related Dates
Export Check for that it contains: Last Modified
Issues - = Document properties, printer
e Save: Save your changes. Publish path, uthers name and Created
absolute path Last Printed
e Don’t Save: Discard an coe
, v rﬁ Manage Workbook SEI:tEd People
changes you've made. N et K Kayla Clay~
»
e Cancel: Don’t close the
workbook.
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Close Excel

If you click the Close button on the title bar when you have only one Excel file open, the workbook will close

and you will exit the Excel program.

Excel closes.

Click the Close button.

& 2- ¢ -

File Home Insert Draw Page Layout Formulas Data
D General icél]
i) B I U $ [
3 O A 7]
Clipboard 1 Font Alignment Number
Ready

Kayla Claypool

Review  View  Help

Styles

H B H -

P Tellme
o R

Cells | Editing
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